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Release Notes for Cisco 6400 Service
Connection Manager, Release 2.0.1

The Cisco 6400 Service Connection Manager (SCM) is a Cisco Element Manager Framework (CEMF)
based element and service management solution for the Cisco 6400 Universal Access Concentrator.
This release note contains compatibility and known problem information which may be relevant for
installers and end users of the Cisco 6400 SCM solution. Also noted are a number of Cisco 6400 UAC
hardware issues that may impact the otherwise correct operation of the Cisco 6400 SCM software.

SCM Release 2.0.1 provides scalability enhancements, bug fixes, and a migration tool for upgrading
from SCM Release 1.2, Release 1.3, and Release 2.0 installations. Like SCM Release 2.0, this releas
of SCM also runs on CEMF Release 3.0.4.

SCM Release 2.0.1 applies for both new and existing installations of SCM. Customers running SCM
Release 1.2 or SCM Release 1.3 can upgrade to SCM Release 2.0.1, which offers improved scalability
more features, CORBA gateway support, and interoperability with the latest Cisco Element
Management Framework (CEMF) 3.0.4 platform. We encourage customers currently running SCM
Release 2.0 to upgrade to SCM Release 2.0.1 to take advantage of the above improvements. Custome
who are installing SCM for the first time must install SCM Release 2.0.1.

New Software Features in SCM Release 2.0.1

Cisco SYSTEMS

®

In addition to the features supported in SCM Release 2.0, SCM Release 2.0.1 supports the following
features:

« Runs on the Cisco EMF Release 3.0.4 platform

- Supports a migration tool for upgrading SCM 1.2 and SCM 1.3 installations running CEMF 2.1.4,
and SCM 2.0 running CEMF 3.0.4, to SCM 2.0.1 running CEMF 3.0.4.

« Improves scalability to support up to 100 Clsco 6400 chassis per SCM server, 200,000 subscribers,
and provisioning 5000 subscribers per day
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W Audience

Supports Cisco 6400 elements running Cisco 10S Release 12.0(7)DB for NSP and Release
12.0(7)DC for NRP

Problem resolutions from previous releases

Software Features in SCM Release 2.0

SCM Release 2.0 runs on Cisco EMF Release 3.0.4, which implements several changes that are visible
when using the Cisco SCM software:

A Quick Start deployment option to deploy a Cisco 6400 quickly with SCM. You can launch this
facility using the menu optiobeployment > Deploy 6400 Quick StartThis option deploys a

fully discovered Cisco 6400 chassis in your chosen site. Please condDistlhe5400 Service
Connection Manager User Guider more information and constraints on this feature.

New icons on the Cisco EMF launchpad—The Cisco EMF Release 2.x Map Viewer and Object
Manager applications have been combined into a single Viewer application.

Supports Telecom Graphic Objects (TGO) in the Viewer application—TGO, a TeleManagement
Forum sponsored standard for element management service (EMS) and network management
service (NMS) applications, displays additional icons on top of the existing object icons displayed
in Map Viewer. These icons provide information such as the state of the object or event status. For
further details, refer to the section “Cisco 6400 SCM Services” in Chapter 2 Gfdbe 6400

Service Connection Manager User Guide.

Supports carrier-class security for Cisco SCM users—Refer to Chapter 11, “Security,” in the
Cisco 6400 Service Connection Manager User Guide.

Introduces connection templates (that is, Cisco IOS VC Classes)—Connection templates allow you
to configure ingress and egress QoS parameters that can be applied over and over again when
connecting a subscriber to a service instance and replacing subscriber QoS objects.

Adds NRP capacity statistics—Refer to the section “Cisco 6400 NRP Capacity Statistics” in
Chapter 5 of th&€isco 6400 Service Connection Manager User Guide

Supports OC-3, OC-12, and DS-3 Node Line Cards (NLC)—Release 1.x of the Cisco SCM
software supported OC-3 and DS-3 NLCs only.

Integrates a number of common components (which provide common EMS windows for a number
of distinct Cisco EMF EMSs)—SCM, Cisco DSL Manager, and the GSR 12000 EMS.

Simplified and improved Service and Subscriber provisioning windows—Subscriber QoS in SCM
Release 1.x has been replaced by Connection Templates (which support use of the correct I0S VC
class). Additionally, reflecting the traditional (single domain) and multi-domain (SSG) options of
the Cisco 6400 service options, the Cisco 6400 SCM subscriber connection process in Version 2.0
provides two methods of subscriber connection to accurately reflect the operation of the Cisco 6400
IOS features.

Support for the Cisco EMF CORBA Gateway—Systems integrators intending to integrate the SCM
into OSS applications via CORBA can do so by using the CEMF CORBA Gateway Developer
Toolkit (http://www.cisco.com/warp/customer/cc/pd/nemnsw/emf/prodlit/crba_ds.htm).

Cisco 6400 Services Supported in Cisco 6400 SCM, Release 2.0

The following Cisco 6400 aggregation services are supported in this release:

ATM switching

Release Notes for Cisco 6400 Service Connection Manager, Release 2.0.1
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- PPPOA Single Domain

« PPPOA over L2TP

- RFC1483 Bridging

- RCF1483 IRB

« RFC1483 Routing (snap)

« |P Uplink, with 6400 Service Selection Gateway, subscriber connection options as follows:
— PPP Terminated Aggregation to Multiple Domains, PTA-MD (PPPoA and PPPoE)
- Routed Bridge Encapsulation (RBE)

System Requirements

CEMF Version 3.0 has been designed for managing large-scale deployments. Customers planning to
upgrade to this release are advised that the recommended deployment hardware specification for the
CEMF Version 3.0 Server is:

- Sun Ultra 60 workstation, 2 CPUs

- 4 GB Disk, + one additional disk for database performance
- 512 MB RAM (1 GB recommended)

- 2 GB swap space

e 17-inch color monitor

- Solaris Version 2.6

In lab trials, it is possible to run CEMF v3 and Cisco 6400 SCM Release 2.0 on the Sun
Ultra 5 workstation, with the above specifications for swap and RAM. Note, however, that
the applications will appear slow.

It is particularly important that any Sun workstation used to run CEMF v3 element
managers such as 6400 SCM has sufficient swap space (2GB) and RAM (512 MB
Minimum). Do not install this software on machines without this minimum specification.

Use the Solaris commandsvap -s andprtconf to determine the available amount of
swap and RAM, respectively, on your machine.

Software Compatibility

This software release was tested on Release 2.6 of the Solaris operating environment, for Sun SPARC
workstations, and for Year 2000 Compliance.

Additionally, Cisco 6400 SCM Release 2.0.1 was tested with the following versions of Cisco IOS:
- NSP: Release 12.0(7)DB

[ 78-11777-01
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« NRP: 12.0(7)DC

Determining the Software Version

To determine installed Cisco EMF packages and version numbers, use the CEMF command:
<CEMFROOT>/bin/cemf install -show

Note ~<CEMFROOTis the installation directory for CEMF and the 6400 SCM software. The
default location is théopt/cemf  directory.

Alternatively, to determine installed Cisco EMF packages, use the Solaris command sequence:
pkginfo | grep -v SUNW

To determine the versions of installed Cisco EMF packages, use the Solaris command:

pkginfo -l <package name>

Upgrading to SCM Release 2.0.1

SCM Release 2.0.1 includes a migration tool for managing an existing SCM database in an SCM 1.2 or
SCM 1.3 installation so that it is accessible after upgrading to SCM 2.0.1. To upgrade from an SCM 1.x
version to SCM Release 2.0.1, you must:

- Use a migration tool to backup and extract the existing database

- Deinstall CEMF Release 2.1.4

- Deinstall SCM Release 1.x

- Install CEMF Release 3.0.4

- Install SCM Release 2.0.1

« Install CEMF Release 3.0.4 patch 5

- Use the migration tool to import data from the existing SCM Release 1.x database

Refer to the guid&pgrading Databases to Cisco 6400 Service Connection Manfageletails on how
to use this migration tool.

If you are upgrading from SCM Release 2.0, you must deinstall SCM Release 2.0, install CEMF patch 5
(or newer), and then install SCM Release 2.0.1

Installation Notes

You must install the Cisco 6400 SCM software onto a running CEMF Server, so be sure to make sure
that the appropriate release of CEMF is installed before you perform SCM installation. Also, check
Cisco Connection Online for the latest patches that must be installed.

CEMF Release 3.0.4 with patch 5 is required for SCM Release 2.0.1.

Release Notes for Cisco 6400 Service Connection Manager, Release 2.0.1



Note

DeinstallingSCM W

CEMF Version 3 supports online element manager installation, and so the Cisco 6400
SCM must be installed onto a running CEMF server.

Note the following conditions pertaining to installation and startup times, especially if you are using
hardware specifications less than the minimums recommended in this document.

- When installed for the first time, CEMF can take up to 30 minutes to start up. This is due to initial
database setup, which only occurs on the first startup. Subsequent restarts are significantly faste

- After it is installed, CEMF starts up each time the Sun Server is booted. CEMF startup time can
take up to 30 minutes in some cases, which may increase the overall boot time of the Sun Servel
If you do not want CEMF to auto-start during the Solaris boot process, disable it by renaming the
CEMEF startup file using the UNIX command:

mv /etc/rc2.d/S99cemf /etc/rc2.d/Unused-S99cemf

- SCM installation time can take up to one hour (or more, if you do not use the recommended
minimum hardware).

Version Support

In particular, for this SCM release, the following components must be installed:
CEMF Version 3.0.4 and CEMF Version 3.0.4 patch 5 (or later)

Deinstalling SCM

To deinstall the Cisco 6400 SCM, use the optammfinstall -r as described in th€isco 6400 Service
Connection Manager Installation Guide

Important Notes: Adding Additional Swap Space

CEMF Version 3.0.x requires 2 GB of swap space. In general, if your machine requires additional swap
space, you should repartition one of the disks to allocate a new swap partition. Use the Solaris commanc
format(1M) and in particular the partition option of this command to partition appropriate swap space.

If you must repartition an existing disk in order to increase swap space, consult a Solaris
system administrator. Repartitioning a disk means that you will lose all data on that disk.

A simple, but less efficient (in performance terms) method of increasing swap space is to create a file
as follows and add the file to your available swap. The following example shows how to add 1 GB swap
to your Sun workstation (assuming sufficient available free disk space).

mkfile 2000m /opt/MY_EXTRA_SWAP_FILE
swap -a /opt/MY_EXTRA_SWAP_FILE

To ensure that this file is added to your swap after a system reboot, remember to add it to your machine’s
Jetc./vfstab file. If in doubt, consult a Solaris system administrator.

[ 78-11777-01
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A

Note  This is not a particularly efficient swap file system and will result in slower application

performance.

Closed Caveats

Caveats Closed Since Last Release

- CSCdr19903: Feature list names in Access Manager application related to CEMF are not
user-friendly.

« (CSCdr34032: There is an occasional intermittent problem with sub-chassis auto-discovery:
occasionally cards which are actually present do not appear in the c6400Manager View. However,
they do appear in the physical view. Workaround is to refer to the physical view in these cases.

« CSCdr34017: Itis not possible to disable power supplies via the Chassis Management tab. Use CLI
commands to enable and disable power supplies.

Caveats

This section describes caveats identified in the Cisco EMF and SCM software.

Cisco EMF Version 3.0.4 Caveats

For a full list of known problems in Cisco EMF Version 3.0.4, consult the appropriate CEMF release

note.

Table 1 lists the CEMF issues that affect the operation of Cisco 6400 SCM Release 2.0.1.

Table 1 Cisco EMF Version 3.0.4 Caveats

DDTS Entry

Description

CSCdr19538

In the Cisco 6400 chassis view, object names overlap and may be difficult to read.
Workaround: None.

CSCdr19601

It is currently possible to deploy subscribers on objects other than ATM ports. This
is not a valid deployment and should be avoided.

Workaround: None.

CSCds19637

When deploying objects, the object selector appears with sites grayed out. To select
the correct object for deployment, remember to navigate through the View hierarchy
(past the grayed-out sites) to find objects for deployment.

Workaround: None.

CSCds19664

Context menus are incomplete after configuring a service or subscriber.
Workaround: None.
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Table 1 Cisco EMF Version 3.0.4 Caveats (continued)

DDTS Entry Description

CSCdr19677 In the generic deployment wizard, under the select relationship dialog, if you select
the PHYSICAL object more than two times, an error message appears indicating that
no object was selected.
Workaround: None.

CSCdr19684 | Access security by managementregion (data partitioning) does not function correctly
if the domain is set up at a CEMF site level.
Workaround: None.

CSCat15804 Attempting to perform a Cisco IOS image download to a device in the errored state
results in an Unable to Login error message if the device is not operational.
Workaround: None. Do not perform a Cisco 10S image download to an errored
device.

CSCat20118 Excessive logging messages are output to the c6400Controller.log file, which can
make it difficult to track down error messages in the log file.
Workaround: None.

CSCat20077 If an NLC is predeployed into a slot that is occupied by another type of NLC, the

object may go into the normal state when commissioned, instead of a mismatched
state.

Workaround: Delete the incorrectly deployed NLC and deploy the correct NLC.

SCM Release 2.0 Caveats

Table 2 lists known problems in this release of the SCM. Unless otherwise noted, there is no

workaround.

Table 2 Open Caveats for SCM Release 2.0

DDTS Entry Description

CSCdr34047 If you manually deploy a Cisco 6400 chassis and subsequently run CEMF
auto-discovery over this range, this chassis appears two times.

CSCdr34055 It can take up to 5 minutes to detect that a card (such as an NRP or NLC) has been
physically removed from the Cisco 6400 chassis, that is, until you see an alarm
condition in the Map Viewer application.

CSCdr34070 Launching CEMF auto-discovery from the NSP object in a Cisco 6400 chassis places
all discovered network elements as children of the NSP in the Physical View.

CSCdr34490 Occasionally, ATM port configuration changes may not be saved; MIB attribute sets
on the Cisco 6400 component fail.

CSCdr34493 | When CEMF IP auto-discovery is run, NRPs can be discovered.

Whenever auto-discovery is launched from a site, the physical view is populated with
the respective shelves and the NRPs lying in that range underneath it, giving the
impression that the NRPs are contained within the site, which is not correct. They
should be either placed under the chassis or should not appear at all until the chassis
is commissioned.

[ 78-11777-01
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Table 2 Open Caveats for SCM Release 2.0 (continued)

DDTS Entry Description

CSCdr34498 Itis possible to use the CEMF Delete menu option to delete subscribers and services.
This deletes the CEMF object but does not remove the relevant Cisco I0S
configuration from the Cisco 6400.

Workaround: Use the appropriate SCM windows, as described itCtheo 6400
Service Connection Manager User Gujde decommission the connections prior to
deleting the subscriber or service object.

CSCdr34504 | Occasionally, the deconfiguration of the PPPoE base configuration on the SSG
Configuration window fails. If this happens, retry the deconfiguration.

CSCdr34523 | The Over Subscription Management button in the L2TP RFC1483 Bridging and
RFC1483 Routed Service is redundant and should not be present. This button has no
function; do not use it.

CSCdr34536 | The Restore option (of previous running configuration) for the NSP object functions
correctly but actually prints out an error message stating that a problem has occurred.
The error message is incorrect; the restore worked properly. This option does function
correctly for the NRP; no erroneous error message appears.

CSCdr34627 If a line card (for example, NRP or NLC) is physically removed from the chassis,
SCM correctly raises an alarm that can be viewed in the CEMF Event Browser. The
SCM Map View does not indicate this error condition.

CSCdr34648 It is possible to delete connection templates using the CEMF Map Viewer Delete
menu while subscribers are still connected using this connection template.

Workaround: Ensure that all subscribers are disconnected first before you delete the
connection template object.

SCM Release 2.0.1 Caveats

Table 3 lists the known problems in Release 2.0.1 of the Cisco 6400 SCM. Unless otherwise noted, there
is no workaround.
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Table 3 Open Caveats for SCM 2.0.1

DDTS Entry

Description

CSCds20126

Do not use the standard deinstallation mechanism when certain Cisco EMF element
managers are installed together. Specifically, if the Cisco 6400 SCM is installed on
the same Cisco EMF server as one of the following element managers, you must not
use the commanemfinstall -r

- Cisco DSL Manager (CDM)
« Cisco GSR Manager (CGM)
« Cisco Multi-Device Manager (Cisco MDM)

- To deinstall the Cisco 6400 SCM from such a deployment, run the following
command:

cemf load -remove CEMFSCMm  for a server installation
cemf load -remove CEMFSCMc for a client installation

« To remove other EMSs from a Cisco 6400 SCM deployntmfotuse
cemfinstall -r for that EMS. Instead, consult the documentation and release
notes for that EMS.

CSCds2041

Occasionally, object lists in the IOS Download window are populated differently,
depending on the Cisco EMF View from which the window is launched. In particular,
downloading to a chassis is equivalent to downloading to the Cisco 6400 NSP. Also,
itis possible that duplicates will appear in this list (that is, the chassis and NSP object
will both be shown).

Workaround: Check manually the objects to which you choose to download
(especially if you use multiselect).

CSCds20187

If there are no profiles available, if you select the Apply Profile menu option from a
service configuration window (for example, L2TP Service Configuration), this causes
a core dump (indicated by the window disappearing). When you select the Apply
Profile menu option, no submenu pop-up appears. If you select the Apply Profile
menu again, the core dump occurs. This also applies for the Delete Profile option.

Workaround: Avoid selecting the Apply Profile option if there are no profiles.

CSCds20203

Preprovisioning a half-height card into a slot where the other sub slot is populated
with a live card can cause Cisco 6400 SCM to indicate that the preprovisioned card
is actually present. The Cisco 6400 SCM incorrectly allows you to Commission this
card.

Workaround: None.

CSCds20210

If an NLC is removed from the Cisco 6400 chassis, the Cisco 6400 SCM correctly
indicates that this card has been removed. However, it is possible that ports on the
card will be incorrectly marked as being in the normal state.

Workaround: None.

CSCat18377

There may be a mismatch between the number of PVCs on a port as reported by SCM
and the Cisco I0Show atm pvccommand. The figure reported by SCM is accurate,
butincludes dynamically created PVCs used for signaling, which are not reported by
the show atm pvccommand.

Workaround: None.

[ 78-11777-01
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Table 3 Open Caveats for SCM 2.0.1 (continued)

DDTS Entry

Description

CSCat19660

If the NRP and NLC objects are deleted from a chassis in SCM, and then sub-chassis
discovery is initiated, the cards are rediscovered correctly. However, these objects
may not show all the alarm conditions present in the alarm table on the Cisco 6400.

Workaround: None.

CSCat19636

Itis possible to commission an NRP object that has the same IP address as an existing
commissioned NRP object.

Workaround: Decommission the duplicate card and delete it.

CSCat19966

If an NRP card is removed from a Cisco 6400 chassis and inserted into another
Cisco 6400 chassis, the SCM should notice this change. However, this may not
always happen if the CEMF server fails to receive the chassis change trap from the
Cisco 6400. This can occur due to network problems, or if the Cisco 6400 is not
correctly configured to send traps to the CEMF server.

Workaround: Manually delete the NRP object from the original chassis, and
redeploy it into the new chassis in SCM.

CSCat19951

Inthe NRP Capacity Statistics window, it is unclear that the Over-Subscription Factor
attribute is a percentage value (for example, a value of 15 means that the NRP is 15%
oversubscribed, not 15 times oversubscribed).

Workaround: The attribute tooltip provides a clear explanation.

CSCat19519

A decommissioned chassis can be deleted, even though there may be active services
and connections on that chassis.

Workaround: None.

CSCat19415

An NRP object can be deleted, even though there may be active services and
connections using that NRP.

Workaround: None.

CSCat19914

A subscriber can be connected to the same service more than one time, even though
it is usually inappropriate to do so.

Workaround: Disconnect duplicate subscriber connections through the Subscriber
Disconnection dialog.

CSCat19644

Service commission and subscriber connection actions can be launched, irrespective
of the state of the port or card.

Workaround: None. If the operation cannot be completed because a port or card is
unavailable, the action will fail and rollback to a consistent state.

CSCat20061

In some rare circumstances, the Subscriber Connection window may “hang,”
displaying the busy watch cursor.

Workaround: Close the dialog and re-open it.

CSCat19789

The SSG Configuration window can be edited after the Configure action has taken
place. When the Deconfigure action is performed, it will try and remove the edited
configuration, which may not match what was originally configured on the device.

Workaround: Avoid making changes to the SSG Configuration dialog after the
Configure action has taken place.
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Table 3 Open Caveats for SCM 2.0.1 (continued)

DDTS Entry

Description

CSCat19904

It is possible to delete a commissioned service, or a connected subscriber and
connection objects, without removing the corresponding configuration from the
Cisco 6400 device.

Workaround: Avoid deleting SCM objects unless you are certain that it is safe to do
so. If these objects are deleted, you should manually remove the corresponding
configuration from the device by using appropriate Cisco I0OS commands.

CSCat20193

If you click on a tooltip associated with an Object List, this may cause the GUI
manager process to crash. This results in the window (and possibly other open
windows) closing. Any unsaved changes on these windows are lost.

Workaround: Reopen the windows from the Map Viewer application.

CSCat19697

The Connect buttons on the Service/Subscriber Connection window can become
disabled or enabled incorrectly.

Workaround: If you select a different tab in the window, then return to the original
tab, may enable the Connect button. If this does not work, close and reopen the
window.

CSCat18935

If two windows are opened in quick succession, their contents can become mixed up,
with the contents of both windows displayed in one window.

Workaround: Close the windows, then reopen them.

CSCat19704

The Cisco 6400 UAC menu options are not available if you right-click an RBE
connection object.

Workaround: Launch the required window from a parent object or the chassis.

CSCat20005

IP address fields may accept invalid IP address values (for example, 0.0.0.0).
Workaround: Enter a valid IP address.

CSCat19609

It is not possible to deploy a Service object by launching the Deployment Wizard
using theCisco 6400 UAC > Service > Deplosnenu from another Service object.
The wizard requires that you select a containment relationship in the
C6400SSManager view, which is hidden.

Workaround: Use theCisco 6400 UAC > Service > Deplognenu option from the
Chassis to deploy a Service object.

CSCat19318

The Uplink VPI and VCI values for an ATM service are not verified when the service
is commissioned. An invalid value can be entered, which subsequently causes
connection to the service to fail.

Workaround: If connection to an ATM service fails, check that the Uplink VPI and
VCI values are valid on the ATM Service Configuration window.

CSCat19634

Nonnumeric characters are accepted as valid input in some fields that require
numerical values.

Workaround: Avoid using invalid characters in these fields.

CSCat19554

If the Disconnect action is performed on the Service/Subscriber Disconnection
window, the following incorrect error message appears: Default Action — Failed:
Check Controller log file for more details. Possible error in state machine file.

Workaround: Select a Connection object before you select the Disconnect button.

[ 78-11777-01
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Table 3 Open Caveats for SCM 2.0.1 (continued)

DDTS Entry

Description

CSCat19470

The Connection Template Configuration dialog and Service/Subscriber Connection
windows do not display connection template objects that were created since the
window was opened.

Workaround: Close and reopen the window to display the new connection
templates.

CSCat19871

The PPP Authentication type mschap does not work correctly on the L2TP and
PPPoA-SD configuration windows. The service commission action fails.

Workaround: To use this authentication type, open the Object Configuration
window for the L2TP or PPPoA-SD service (right-click the Service object, and select
Tools > Open Object Configuratior). From the Object Types selector, select
VirtualTemplate , then entems-chapas the value for the attribute
C6400SSControl-MIB.vtAuthenticationType. Save this change, and close the Object
Configuration window. The service can now be commissioned.

CSCat19791

In the SSG Configuration window, if the Deconfigure button on the PPPoE
Configuration tab is selected, and PPPoE was not configured (or was deconfigured
already), an incorrect error message PPPOA is already Deconfigured appears.

Workaround: None.

CSCat19295

The Connection Template Configuration window does not validate QoS values.
Incorrect values are rejected if the connection template is used to connect a
subscriber.

Workaround: If an error occurs when connecting a subscriber, check that the
connection template has valid values.

CSCat19399

The Current Connections object list on the ATM Service Configuration window may
remain empty, even though there is a connection to this service.

Workaround: Open the Service/Subscriber Disconnection window from the
ATM Service object. This shows details of the connection to this service.

CSCat20202

In the Line Card Management window, the Module Type attribute is incorrectly
reported for OC-12 NLCs. This should be reported as OC-12 Single Mode Fiber.

Workaround: None.

CSCat19582

In the Service/Subscriber Connection window, the Service Type attribute on the
Single Domain tab uses the old SCM service naming convention.

Workaround: The correct name mappings are as follows:
ATM = ATM
Bridged-Bridged = RFC1483 Bridging
Bridged-Routed = RFC1483 IRB
PPP-L2TP = L2TP
PPP-IP = PPP0OA-SD
PTA-MD = IP Uplink
RFC1483 = RFC1483 Routing

Release Notes for Cisco 6400 Service Connection Manager, Release 2.0.1



Caveats M

Table 3 Open Caveats for SCM 2.0.1 (continued)

DDTS Entry

Description

CSCat19954

Some action reports include extra debugging information that is not relevant to the
user. Ignore this extra information.

Workaround: None.

CSCat18410

The Global Performance Logging button on the Chassis Configuration window does
not turn on bandwidth utilization monitoring on ATM ports.

Workaround: Turn on bandwidth utilization manually from the Interface
Performance dialog.

CSCatl17425

If an RFC1483 Routing service is decommissioned while there are subscribers
connected to the service, the decommission action may fail and show the following
error message: Updating ATM port bulk list result in error.

Workaround: Do not decommission a service while there are subscribers connected
to it.

CSCatl7727

It is possible that some of SCM'’s help files could be overwritten by the installation
of another EM package onto the same CEMF server. In particular, the installation of
Cisco DSL Manager overwrites the help files for some of the common windows used
by both applications. The help file is still relevant for the window, but may link to
other CDM help files instead of SCM files.

Workaround: None.

CSCat16899

The Username and Password fields should be separated. Currently these are
combined into a single field, with Username and Password separated by a space.

Workaround: None

CSCatl7632

Deletion of connection templates is possible, even if the template is being used by a
subscriber connection.

Workaround: None. Use the Delete button on the Connection Template
Configuration window to delete connection templates.

CSCatl16770

Cisco 10S interaction scripts can time out under severe adverse network conditions

Workaround: The default timeout setting is 60 seconds. You can change this by
creating a timeout file that contains the new timeout value in seconds. Create the file
in the directoryxCEMFROOT>/config/perl . For example, the following command,
executed as root, sets the timeout value to 120 seconds (where /opt/cemf is the default
CEMF installation directory):

echo 120 >  /opt/cemf/config/perl/timeout

CSCatl18441

The Service/Subscriber Connection window requires that you use the Save button or
the File > Savemenu option to save attribute changes before selecting an action
button. Otherwise, the updated values are not used by the action. This is inconsistent
with the operation of the Service Configuration windows, which automatically save
changes when an action button is selected.

Workaround: Save changes before you select an action button.

[ 78-11777-01
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Table 3 Open Caveats for SCM 2.0.1 (continued)

DDTS Entry

Description

CSCat16269

The Deployment Wizard incorrectly allows the deployment of objects directly
beneath the root of a view. If you deploy certain SCM objects incorrectly (such as
Services or Subscribers), this causes operations to fail.

Workaround: Avoid deploying Service or Subscriber objects beneath the root of the
Service or Subscriber views. Delete incorrectly deployed objects, and deploy them
correctly.

CSCat16404

The Encapsulation Type options on the Service/Subscriber Connection window may
not be appropriate for the selected service. For example, the options aal5mux ppp and
aal5cisco ppp are available for connections to RFC1483 Routing services.

Workaround: Ensure that the correct encapsulation type is selected.

CSCat17607

The Status display at the bottom of some SCM windows incorrectly displays the state
of some objects as having no value.

Workaround: Determine the correct state of the objects by launching the
corresponding management dialog (for example, NRP Management dialog for
NRPs).

CSCat16042

Inthe IP Uplink Service Configuration window, it is possible to enter duplicate values
in the Next Hop Gateway Key field, which could affect the stability of the service.

Workaround: Avoid entering duplicate values in this field. If a service was
commissioned with a duplicate key, decommission the service and correct the error.

CSCat15857

The value of the Administration Status attribute on the Cisco 6400 NRP Management
dialog cannot be changed.

Workaround: Use Cisco I0S to change the Administration Status of the card.

CSCat18672

In the RFC1483 Routing Service Configuration window, if you select the Add button
on the Service Uplink tab, this creates a new Service Uplink. However, if you select
this button, this action causes unsaved changes to the service to be lost.

Workaround: Before you create a new Service Uplink, click 8mseicon or the
File > Savemenu option to save any changes to the service.

CSCat16179

It is possible to connect a Subscriber to the same Service more than one time.
Although this is usually not a sensible thing to do, SCM does not prevent it.

Workaround: Use the Service/Subscriber Disconnection window to disconnect
additional connections.

CSCat19916

Data migration from SCM Release 1.x to SCM Release 2.0.1 may fail if all of the
following conditions are true:

- In SCM Release 1.x, there is an NRP object deployed with no IP address set in
SCM.

< The NRP is deployed in a slot that is empty on the actual Cisco 6400 chassis.

« There is an NRP in another slot in the Cisco 6400 chassis, but there is no
corresponding NRP object in SCM.

Workaround: In SCM Release 1.x, delete the NRP object, and deploy a new NRP
object that correctly matches the Cisco 6400 device configuration.
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Table 3 Open Caveats for SCM 2.0.1 (continued)

DDTS Entry Description

CSCat19936 The ATM Port management windows may not work correctly with ATM port objects
migrated from SCM Release 1.x. This is because of a problem in the Cisco 6400
I0S software, which is worked-around for nonmigrated ATM port objects, but not for
migrated ones.

Workaround: Open the Object Configuration window for the ATM Port object
(right-click the ATM Port object, and selectools > Open Object Configuration).
SelectsnmpManageable and enter the valukfor the attribute
snmp-varbinds-per-packet. Save this change and close the Object Configuration
dialog.

CSCat19685 The Authentication Type attribute of an L2TP service may not be correctly migrated
from SCM Release 1.x to SCM Release 2.0.1.

Workaround: Select the correct Authentication Type before you commission the
service (also see CSCat19871).

Related Documentation

In addition to the Cisco 6400 Service Connection Manager Release 2.0.1 documentation, refer to the
Cisco Element Management Framework User GaidéCisco Element Management Framework
Installation Guidefor Cisco EMF Release 3.0.4.

Obtaining Documentation

The SCM Release 2.0.1 user and installation guides are available on Cisco Connection Online (CCO
at http:.//www.cisco.com in both HTML and PDF format.

Cisco Connection Online

Cisco Connection Online (CCO) is Cisco Systems’ primary, real-time support channel. Maintenance
customers and partners can self-register on CCO to obtain additional information and services.

Available 24 hours a day, 7 days a week, CCO provides a wealth of standard and value-added service:
to Cisco customers and business partners. CCO services include product information, product
documentation, software updates, release notes, technical tips, the Bug Navigator, configuration notes
brochures, descriptions of service offerings, and download access to public and authorized files.

CCO serves a wide variety of users through two interfaces that are updated and enhanced
simultaneously: a character-based version and a multimedia version that resides on the World Wide Wet
(WWW). The character-based CCO supports Zmodem, Kermit, Xmodem, FTP, and Internet e-mail, and
it is excellent for quick access to information over lower bandwidths. The WWW version of CCO
provides richly formatted documents with photographs, figures, graphics, and video, as well as
hyperlinks to related information.

You can access CCO in the following ways:
- WWW: http://www.cisco.com
« WWW: http://www-europe.cisco.com

[ 78-11777-01
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Note

- WWW: http://www-china.cisco.com
« Telnet: cco.cisco.com

- Modem: From North America, 408 526-8070; from Europe, 33 1 64 46 40 82. Use the following
terminal settings: VT100 emulation; databits: 8; parity: none; stop bits: 1; and connection rates up
to 28.8 kbps.

For a copy of CCO'’s Frequently Asked Questions (FAQ), contact cco-help@cisco.com. For additional
information, contact cco-team@cisco.com.

If you are a network administrator and need personal technical assistance with a Cisco
product that is under warranty or covered by a maintenance contract, contact the Cisco
Technical Assistance Center (TAC) at 800 553-2447, 408 526-7209, or tac@cisco.com. To
obtain general information about Cisco Systems, Cisco products, or upgrades, contact
800 553-6387, 408 526-7208, or cs-rep@cisco.com.

Documentation CD-ROM

Cisco documentation and additional literature are available in a CD-ROM package, which ships with
your product. The Documentation CD-ROM, a member of the Cisco Connection Family, is updated
monthly. Therefore, it might be more current than printed documentation. To order additional copies of
the Documentation CD-ROM, contact your local sales representative or call customer service. The
CD-ROM package is available as a single package or as an annual subscription. You can also access
Cisco documentation on the World Wide Web at http://www.cisco.com, http://www-china.cisco.com,

or http://www-europe.cisco.com.

If you are reading Cisco product documentation on the World Wide Web, you can submit comments
electronically. ClickFeedbackin the toolbar and sele@ocumentation After you complete the form,
click Submit to send it to Cisco. We appreciate your comments.

Obtaining Technical Assistance

Contact the Cisco TAC for product support on Cisco 6400 SCM Release 2.0.1.
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